
<Crew Logo> <Crew Name> 
Homepage: 
<Homepage> 

Contact: 
<Contact> 

File ID: 
S1_JPG_083.pdf 

Title: 
Shenmue Japanization Guide 

Version: 
0.8.3 

Date: 
2012-04-27 

Effective for: 
<Project> 

Created: 
2012-04-27 Shensoul 

Classification: 
DRAFT 

Approved:  
<Date> <Name> 

 

<Crew Name> Shenmue Japanization Guide Page 1 of 32 

Table of Contents 

1 Disclaimer...................................................................................................................................2 

2 Purpose .......................................................................................................................................2 

3 Scope ..........................................................................................................................................2 

4 Terminology / Abbreviations .......................................................................................................3 

5 Introduction ................................................................................................................................4 

6 Preparation ..................................................................................................................................5 

6.1 Extraction of the Core ..........................................................................................................5 

6.2 Extraction of the Japanese audio and subtitle files ................................................................6 

6.3 Creation of a translation environment ..................................................................................7 

7 Translation ..................................................................................................................................8 

7.1 The STREAM folder ...........................................................................................................8 

7.2 Cinematics...........................................................................................................................9 

7.2.1 Extraction of original AFS container ............................................................................9 

7.2.2 Modification of subtitles ............................................................................................ 10 

7.2.3 Recreation of new AFS container ............................................................................... 12 

7.2.4 Recreation of valid IDX file ....................................................................................... 12 

7.3 Free Quest ......................................................................................................................... 13 

7.3.1 Container FREE0x ..................................................................................................... 13 

8 Passport .................................................................................................................................... 13 

9 Details ...................................................................................................................................... 14 

9.1 Shenhua intro sequence ..................................................................................................... 14 

9.2 Original vending machine .................................................................................................. 14 

9.2.1 Drink selection screen and drinking animation ........................................................... 14 

9.2.2 Free quest mode ......................................................................................................... 14 

10 Test image creation ............................................................................................................... 15 

11 Testing .................................................................................................................................. 16 

12 Sources ................................................................................................................................. 17 

13 Document history .................................................................................................................. 17 

14 Appendix .............................................................................................................................. 18 

14.1 AFS container list .............................................................................................................. 18 

14.2 Vending machine files ....................................................................................................... 25 

14.3 Disc scene list .................................................................................................................... 25 

14.4 Character ID list ................................................................................................................ 27 



<Crew Logo> <Crew Name> 
Homepage: 
<Homepage> 

Contact: 
<Contact> 

File ID: 
S1_JPG_083.pdf 

Title: 
Shenmue Japanization Guide 

Version: 
0.8.3 

Date: 
2012-04-27 

Effective for: 
<Project> 

Created: 
2012-04-27 Shensoul 

Classification: 
DRAFT 

Approved:  
<Date> <Name> 

 

<Crew Name> Shenmue Japanization Guide Page 2 of 32 

 

1 Disclaimer 
This document and the information therein shall not be understood as any kind of liability and it may 
be changed without any notice at any time. Any usage of this document occurs exclusively at the 
individual users own responsibility. 
The author(s) of this document assume absolutely no responsibility for any errors that may appear in 
this document or any complications that are caused by the (ab)use of this document. 
In no event shall the author(s) of this document be liable for any damages of any kind arising from the 
(ab)use of the knowledge that is stored in this document. 
 
This document is not designed to be used in countries where modification of video game data is 
prohibited by copyright laws. Stop reading right now if you live in such a country! 

2 Purpose 
The purpose of this document is to provide a complete and illustrated tutorial about how to “japanize” 
the PAL version of the SEGA® Dreamcast™ video game Shenmue™. 
The guide is based on the explanations written by Hiei- for Manic, the knowledge provided by the 
Shentrad team on their homepage and the knowledge provided by the shenmuedojo.net and 
metagames-eu.com forum members (for detailed sources go to chapter 12). 

3 Scope 
The methods which are described in this document are supposed to only be used for “japanization” 
tasks of SEGA® Dreamcast™ Shenmue™ PAL. There is absolutely no warranty (explicit or implied) 
that it will also work with other versions. 
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4 Terminology / Abbreviations 
Technical: 
Google® An American company, provides a free translation service 
SONY® A Japanese company 
Philipps® A Dutch company 
SEGA® A Japanese company, created Shenmue™ and the Dreamcast™ 
Dreamcast™ A video game console of the 6th generation created by SEGA® 
Shenmue™ A video game for the Dreamcast™ 
Byte A unit which describes the size of digital data 
MB Megabyte, means either 10002 or 10242 bytes 
GB Gigabyte, means either 1000 or 1024 MB 
PNG Portable Network Graphics, an image format 

PAL 
Phase Alternating Line, an analogue television encoding system used mainly in 
European countries, a PAL video game is designed for the European market 

NTSC-J 
National Television System Committee Japan, encoding system like PAL, used 
in Japan, a NTSC-J video game is designed for the Japanese market 

GD-ROM Gigabyte Disc Read Only Memory, optical disc format for the SEGA® 
Dreamcast™ optical drive, about 1.2 GB capacity, split to different areas, low 
density area can be read by a computer but it contains nothing of special 
interest (usually bonus pictures or music), high density area contains the game 
data itself 

CD Compact disc, developed by SONY® and Philipps®, optical disc format, used 
to store digital data, usually 700MB space, also available with 800MB space 

CD-R Compact disc recordable, variation of the CD, can be recorded once 
USB Universal serial bus, a standard for computer periphery 

GDI 
Full and untouched 1:1 copy of a GD-ROM, divided into several smaller files 
(formats like .raw and .bin) which the .gdi file seems to be linking together, 
usually about 1GB large 

CDI 

Discjuggler image format, 1 single .cdi file, often used as format for pirated 
Dreamcast ™ games, pirated .cdi game images are usually shrunk to fit on a 
700MB or 800 MB CD-R, 
It is possible that pirated CDI disc images from the internet are unusable 
for translation tasks because they are not untouched 1:1 copies. 

 
General: 
etc. abbreviation for “et cetera” / “and so forth/on” 
e.g. abbreviation for “for example” 
stream media stream, audio and subtitle files 
cinematics cinematic scenes (e.g. intro sequence with Lan Di) 
free quest free quest mode (walking around, talking to people etc.) 
NPC non-playable-character (people like Ine-san) 

 
And some important basic knowledge about the file formats that are used:  
AFS Container, uncompressed, usually filled with subtitle and voice files 
       SRF Subtitles 
       STR Audio, voices 
       XML  File with information about where a AFS has been extracted to 
IDX Index file, belongs to AFS with same name, contains information about AFS 
PKS Container, filled with model data (e.g. face and body) 
PKF Container, filled with textures or face morphing and subtitle data for NPC’s. 
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5 Introduction 
The basic objective of such a “japanization” could be described as upgrading a Shenmue™ PAL game 
as near as possible to the NTSC-J version without losing the English text in the game.  
The main difference between the 2 versions is of course the Japanese dub which is considered by some 
fans as more authentic. This would represent the main reason for such a customization. There are also 
other minor differences like the design of the vending machine which is considered to be more 
authentic in the Japanese version. 

A complete translation of the Japanese version would be extremely time-consuming. It would be 
necessary to translate all subtitles, plus all menus, plus the notebook entries, plus the move scrolls, 
plus the loading screens and possibly even more. This would be a waste of time because the 
mentioned stuff is already translated in the PAL version. 

According to http://fileforums.com/showthread.php?t=50423 it is possible to only inject the Japanese 
voices (.str files) from a Japanese game to an English one instead of translating stuff. If done so the 
lips will most likely be out of sync because it seems like SEGA® reanimated every conversation when 
Shenmue™ was translated to English. They might have done this in order to match the new English 
speech better or to have more flexibility for the translation. However if you are just injecting Japanese 
voice files to PAL AFS containers the animations will possibly look trashy because the old English 
speech animations will remain the same instead of being adapted to the Japanese voices. 

Translating the complete Japanese stream (all AFS containers) and swapping it from one version into 
the other one seems to be the best way to get the best possible quality. It should end up in having a 
PAL Shenmue™ with Japanese dub, perfect lip-sync and English text. Other files like the ones for the 
original vending machine can also easily be swapped. 

The following things are necessary for the translation tasks: 

• Winrar (archive extraction) 
• GDI dumps of Shenmue™ PAL and Shenmue™ NTSC-J 
• GDI Explorer (to extract the data from your images) 
• AFS Utils (to extract the audio and subtitle data from the container) 
• AIO Cinematic Subtitles Editor (to edit the subtitles) 
• IDX Creator (to create a new valid index file for your new container) 
• (possibly) pvrext.exe and pvr2png (to extract and convert textures) 
• Bootmake (to create a bootable CDI image for testing) 
• binhack32.exe for modifying the IP.bin file for the image creation 
• nullDC Dreamcast™ emulator (to test your work without wasting CD-Rs) 

Most of the tools are available at the Shentrad homepage in the download section! It is recommended 
to get the latest versions of the tools.  

It’s highly recommended to backup all images and tools before starting with the translation! 
If you mess up some files you can extract them again from the original files. 
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6 Preparation 
It is recommended to create a decent folder structure for the project. It may look like this: 

Project   (main project folder) 
|___ Disc1  (subfolder for disc 1) 
|___ Disc2  (subfolder for disc 2) 
|___ Disc3  (subfolder for disc 3) 
Disc 4 (Passport) is not part of the story so you might forget it for now.  

This is important because there are a lot of files and folders to manage and such a folder structure will 
help you to keep the overview. You can store this project folder on an external drive if you like. 

6.1 Extraction of the Core 
Open the .gdi file of disc 1 of your Shenmue™ PAL version with GDI Explorer. The dump is not 
saved as a single image file like known from ISO images but rather divided into several smaller files 
(.raw and .bin) which somehow seem to be linked together by the .gdi file.  
GDI Explorer should look like this after opening the GDI file: 

  

You will notice that there is a low and a high density area. The high density area is where the game 
data is stored. The other one contains only some bonus stuff like pictures which is not important for 
the translation itself but possibly nice for you as a fan. 
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Highlight all data in the high density area with your mouse and press the right mouse button. Click on 
“Extract selected files to …” and browse for the subfolder for disc 1 of your project folder.  

 

Navigate to the subfolder of disc 1 of your project folder and press OK. GDI Explorer should now be 
extracting the data of your disk to the project subfolder. A message should appear after the complete 
extraction. Repeat this step for discs 2 and 3 as well.  

The files that were extracted are the core of the new version. It will have the translations of most of the 
content like menu entries, move scrolls and the notebook. It “only” needs the Japanese stream files 
with the modified subtitles and if required the other things from the NTSC-J that you like more (like 
the original vending machine). 

6.2 Extraction of the Japanese audio and subtitle files 
Now open your NTSC-J image with GDI Explorer and browse to the following folder: 
SCENE\01\STREAM (that’s where the Japanese voices and subtitles are stored) 

Highlight all files in this folder and press the right mouse button to extract those files to another folder 
(except of your project folder) on your computer. These files are the Japanese container files which 
contain the audio and subtitles. 

The Japanese containers of disk 2 and 3 are stored in the following folders of the GDI images:  

SCENE\02\STREAM   (disc 2) 
SCENE\03\STREAM  (disc 3) 
Disc 4 is not part of the story so forget it for now and close your GDI Explorer.  
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6.3 Creation of a translation environment 
At this point you should create another folder structure outside of your project folder. This new 
structure should be used for the translation process itself. It could look like this: 

Trans    (main translation task folder) 
|___<disc#>   (disc number) 
|___ J    (subfolder for extracted Japanese containers) 
|___ E    (subfolder for extracted English containers) 
|___ JE    (subfolder for translated containers) 

Move the extracted files from the Japanese stream folder to the “J” folder and copy the original stream 
folder files from your project folder to the “E” folder.  

You should translate a container from a “J” folder with the same container from the “E” folder as a 
template for your translation. Then move the newly created container to the “JE” folder and delete the 
original J and E folder’s container files. This will ensure you that you are not translating a container 
twice because the completed ones are deleted after the translation. You won’t waste time searching the 
right containers. 

After some time you may copy your completed containers from “JE” to the STREAM folder of your 
project subfolder (copying means replacing the original files in this case). Don’t delete your JE folder 
containers and make sure you have a backup of your completed containers from the JE folder (e.g. on 
a USB drive)! 

The idea behind this is outsourcing of translation tasks away from the original project folder. It won’t 
have disastrous impacts to the project if something gets messed up or a hard drive crashes.  

OK, let’s summarize: the following subfolders in your project folder are important:  
<disc 1 subfolder>\SCENE\01\STREAM 
<disc 2 subfolder>\SCENE\02\STREAM 
<disc 3 subfolder>\SCENE\03\STREAM 

These are the folders where the Japanese container files with the translated subtitles have to be copied 
to. The idea is copying more than only the AFS and IDX files to your extracted PAL version because 
there are some vending machine textures and models for the drink selection screen and the drinking 
animation as well in this folder. 
In the beginning it will be filled with the original containers of the PAL version. Replace an original 
AFS container as soon as you fully translated the subtitles of a Japanese container. This will keep the 
disc up to date and don’t forget the vending machine files! 
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7 Translation 
This chapter will cover the knowledge you need to translate the files. 
 

7.1 The STREAM folder 
The main task from now on will be translating all the subtitles. There are cinematic scene subtitles and 
free quest mode subtitles in Shenmue™. It is important to know the difference. 

All subtitles and audio files are grouped in AFS containers and stored in the STREAM folder of the 
disc. An AFS container is usually filled with .str files (voices) and .srf files (subtitles).  

Most of the containers in this folder belong to one specific cinematic scene (the container A0114.AFS 
for example contains the audio and subtitle data for the intro sequence). In order to modify the subtitle 
file (SRF) which is stored in the AFS container you will need to extract the container first (like you 
may know it from .zip or .rar archives).  

FREE0x.AFS (x stands for the disc number) is a container which contains all the free quest subtitles. 
The FREE0x container is similar to the “ordinary” cinematic containers like A0114 which belong to a 
specific scene. The only difference is that the FREE0x container has several subtitle files and several 
sets of audio files while a cinematic container has only 1 subtitle file and 1 set of audio files (just what 
is necessary for a specific cinematic scene).  
Compared to the cinematic containers you will see much more subtitle files (J disc 1 has 160+) and 
much more subtitles (disc 1 has about 50 lines per subtitle file). This means that the translation of the 
free quest subtitles is unfortunately more time-consuming compared to the cinematics.  
The subtitles in the FREE0x container can be edited after extraction with the same tools like the 
ordinary cinematic containers. 
 
The HUMANS.AFS container is different than the other AFS containers. There are no .srf or .str files 
(subtitles and audio) in it. Instead of them it has a lot of PKS and PKF files. A PKS file is a container 
filled with models (face and body of NPCs) while the PKF file contains textures or face morphing data 
and the subtitles of the model from the corresponding file in FREE0x. So basically these containers 
are the characters itself (for example INE_.pks from disc x contains all data for Ine-san in disc x). 
It is recommended to leave this container untouched! Changes are not necessary here. 
 
There are subtitle files in the PAL version which seem to be Japanese (weird characters if opened by 
the sub editor) and not translated yet (01BUS, 01NEK, A0134, A0142, SA1008, SA1092, SY01, 
SY02, SY03, SY04, SY05 and SY06 from disc 1 are confirmed to be such files). It is possible that 
these cinematic scenes got kicked out at some point of the development because they were not 
necessary. If you see such files leave them as they are. 
 
Then there are PKS and PKF files in the STREAM folder like CAFE, COKE, FATG, FATO, SPRT, 
VEND (model and texture files for the vending machine and soft drinks) and a file called 
HMOT_CAN.BIN (the animation file). Don’t forget to swap these files too because the real brands 
make the game more authentic. You don’t need to swap ATRK (winning can) and HIT (smileys). 
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7.2 Cinematics 
It is less time-intensive to translate the cinematic containers so translating the cinematics of all discs 
should be considered as the first priority in case of a serious project. Some containers are found in 
more than only 1 disc. You don’t have to translate them over and over again, just use the one you 
already translated. 

7.2.1 Extraction of original AFS container 
Open AFS Utils. Go to File > Open directory … and browse the STREAM folder of your original 
Japanese disc 1’s image. AFS Utils will look like this: 

 

Highlight one of the AFS containers in the “Files list”, go to Tools > Mass extraction and choose a 
folder where your AFS containers will be extracted. I would recommend you to use the folder 
structure we discussed in the previous chapter. Extracting it to a folder called “J” would be a good 
option.Now repeat this step again for the English original subtitles and extract them to the “E” folder. 
It is almost impossible to translate the subs without using the original English subtitles as templates. 
You may close AFS Utils after the extraction process. 

IMPORTANT!  
Don’t change the path of the extracted containers! After the extraction process a “?_list.xml” file in 
each container’s subfolder will remember the place where the container has been extracted to and 
where the other files are stored. If you move the subfolder to another place at any time AFS Utils 
won’t be able to recreate the container from the “?_list.xml” file. That’s why you need to think of a 
good folder structure before extracting the containers. 
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7.2.2 Modification of subtitles 
Extract AIO Cinematic Subtitles Editor twice into your translation folder (with different subfolder 
names of course) and open both of them. Go to File > Open directory… and browse for an extracted 
AFS data folder like A0114 (with one AIO CSE the Japanese and with the other one the English one). 
Click on the SRF in the files list and the editor will show the subs. 

 
(In the left window we have the Japanese SRF and the English one is in the right window) 

It seems like the application is unable to display Japanese characters and so it will result in having a 
bunch of weird characters displayed instead. In the editor window you can edit the subtitles by 
clicking on them. That’s why it is recommended to use the English subtitles as a template. It doesn’t 
show Japanese characters which you could copy and paste into the Google® translator. 

Enter your English subtitles in the new text box and don’t forget to save your file at the end if autosave 
is disabled. If you messed up something with the file you may delete it and extract it again from your  
backup (that’s why we are not working in the project folder itself…).  

Useful and important tips for the translation: 
It is possible that the J and the E versions don’t have the same amount of subtitles (e.g. because of 
omitted sentences) or the order of subtitles may be different. In such a case you will unfortunately 
have to play try and error until you find out where which translated subtitle belongs to. That’s also 
why it is not smart to inject the Japanese voices only because possibly the total amount of voice files 
needs to be equal to the total amount of sentences in order to get valid AFS and IDX files afterwards. 

Each line can display about 44 characters (depending on the character’s size) from which about 36 
(depending on the character’s size) won’t be hidden by Ryo’s watch in the lower right corner of the 
screen. You can use a maximum of 2 lines per sentence for each dialog. Your subtitles might get 
displayed incorrectly if they exceed the 44 character / 2 line limitations so just don’t violate these rules 
and everything will be fine. There are no other known limitations so far.  
The amount of lines per sentence after the translation does not have to be the same as in the Japanese 
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original. You can fill 2 lines for the sentence even if the Japanese version has only 1 line. 
If your translated sentence exceeds the 36 character limit stretch it from 1 line to 2 lines (with a line 
break) or if your sentence already has 2 lines shrink the amount of words. Try to keep the right 
meaning of the sentence in such a case.  

Another thing is that the translation of the Japanese names and suffixes (–kun, –niichan, -neechan or  
–chan) has not been adapted 1:1 to the English version (e.g. Ryo calls Nozomi “Harasaki” and she 
calls him “Hazuki-kun”). It would be nice to translate it as near as possible to the original. 

A useful hint: 
Go to File > Export subtitles in your sub editor to save SRF subs (Japanese/English) as .xml files. 
You can open XML’s with your browser. A Japanese one may look like this: 

 
It is also possible that there won’t be any Japanese characters at all but rather the same trash you 
already knew from the subtitles editor. In such a case your only help will be the English SRF file and 
you will have to experiment with the translation. Try to make the right translation. If the Japanese 
characters are displayed correctly and if you can read them you can translate it by heart. If you can’t 
read Japanese characters you may copy them to your clipboard and use Google® translator to translate 
it to English. Don’t forget to enable the Romanization [Ä] of the characters as this is quite useful! 

 
Sometimes Google translator may give you strange outputs for names like “Rantei” or “Hadzuki” 
instead of “Lan Di” and “Hazuki”. In such a case you can remain on the English original script. 
If you notice that the Japanese SRF has the same structure like the English template (same amount of 
lines and sentences) you can save the English SRF as a XML and then reimport this XML to your 
Japanese SRF instead of translating dozens of lines.  
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7.2.3 Recreation of new AFS container 
After translating the SRF file it is time to recreate the modified AFS container. Go to your open AFS 
Utils again and go to Tools > AFS Creator. A new window will pop up.  

Go to File > Import XML list and browse to the folder of your modified AFS file. Click on the 
XXXX_list.xml file and import it. A bunch of files should appear in the files list. If not you might 
have moved the extracted data from its original folder where it was extracted to. 

 

Go to File > Save AFS and save it to your “JE” folder. Then you may close AFS Utils again. 
This AFS has to have the same name like the original AFS! 

It is necessary to perform this step via importing the .xml file. If you don’t do it this way you will 
end up having a AFS that won’t be recognized by IDX Creator in the next step! 

7.2.4 Recreation of valid IDX file 
Open IDX Creator. You may leave the “Create 
with template” box unchecked for cinematic files 
as it seems not to be absolutely necessary.  
Browse for your modified AFS file and hit the 
“Go!” button. 
Especially have a look at the status bar below the 
“Go!” button. If there are any problems to create 
this new AFS file they will appear as a message in 
this status bar. Keep an eye on it and make sure 
you created proper files. It is also possible that you 
need to use the original files as templates so don’t 
delete them yet. 
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7.3 Free Quest 
The translation of the free quest mode subtitles is tremendously time-intensive because there are so 
many NPC’s in Shenmue™ which can say so many different things to you (and all these dialogs have 
a subtitles which need to be translated).  
It should be performed at the end of a possible project otherwise you might get frustrated. It is 
recommended to form a crew which will be performing this work like the group that translated 
Shenmue II™ into French. They released their version on 2012-01-25 and nearly all the text was 
translated into French. 

7.3.1 Container FREE0x 
The FREE0x container (x stands for the disc digit) is the first big issue and very similar to the other 
AFS packages. It seems like this package is storing the free quest voices and subtitles. 
The only difference is that you will have more than only 1 subtitle file and you will have more than 
only one set of voice files in it. FREE01 (the package from disc 1 of Shenmue™) for example has 
about 18’000 voice files, about 160 subtitle files (SRF) and each subtitle file has about 50 lines which 
need to be translated. Each subtitle file belongs to one certain NPC (F1005.SRF for example belongs 
to Ine-san) and it contains all dialog subtitles for the voices of the NPC (like when Ine-san talks to Ryo 
in the Hazuki residence).  
 
Modifying the SRF files in the FREE folder is not much different than translating the cinematic 
subtitles. Just open your subtitle editor as described in chapter 7.2.2 and navigate to your extracted 
FREE folder. Open 1 SRF file and translate it using the English SRF as your template. Use the same 
guidelines (line length, amount of lines) for the translation as you used in the cinematic task. 
 
It makes no sense to open all SRF files because you will most likely not have the time to translate 
every file in only some hours. The other issue is that your subtitle editor might crash if you try 
opening all subtitle files from the FREE folder because there are so many files. 
It is important to remember which SRF is already translated so you should consider writing the 
file names and location to a list every time you complete it.  
 
After all subtitles are translated you may rebuild the FREE0x.AFS package and recreate a valid IDX 
file as described in chapters 7.2.3 and 7.2.4. This will take a while because the archive is huge.  
You will have to create the new IDX file for the FREE container with the original files as 
templates otherwise IDX creator will say the new FREE0x.afs is no valid file so check the boxes 
and browse for these files (don’t delete or lose them). 

8 Passport 
The Shenmue™ Passport (disc 4) is not part of the story and so this chapter will be left void for now 
because it has no priority. 
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9 Details 
There are still some things left that can be improved. 

9.1 Shenhua intro sequence 
A0100.AFS from the disc 1 STREAM folder contains the audio and subtitle files for the Shenhua intro 
sequence. The subtitles are blanked out on both versions and the Japanese subtitle file can’t be edited. 
If you want Japanese speech and English subtitles you will have to extract both containers (PAL and 
J). Then you will need to edit the PAL subtitle file with your editor (search the internet for the 10 
lines). Then you need to move the Japanese voice files from your Japanese extracted container folder 
to the European one’s folder. Then rebuild the AFS and create a new IDX file.  

9.2 Original vending machine  
The original vending machine from Shenmue™ NTSC-J features soft drink brands like Coca Cola® 
while the one in PAL only has invented brands like “Jet Cola”. The invented brands make the game 
less authentic. In Shenmue™ you have to distinguish between: 
- the textures of the vending machine itself in the free quest mode  
- the textures of the cans in the selection screen (after throwing coins in the machine) and the drinking 
animation.  
In order to get the original vending machine you need to do some file swapping. It is possible 
that there are more files to swap than described in the next chapters! 

9.2.1 Drink selection screen and drinking animation 
The models and textures (PKS/PKF) for the drinking animation and the drink selection screen are 
located in the STREAM folder and in the VEND folder of SCENE/0x.  
The interesting files are called “VEND, COKE, SPRT, FATO, FATG, CAFE”. The winning can is 
called “ATRK” and it does not have to be swapped. HIT contains only some smiley textures and you 
don’t need to swap it either. The animation of the drinking scene is called “HMOT_CAN.BIN”.  
If you swap these files from your Japanese version to your custom version you will have the real 
brands in the selection screen and the drinking animation but the vending machine itself in the free 
quest mode will still look the same. 

9.2.2 Free quest mode 
Getting the original vending machine textures for the free quest mode is a bit more difficult because it 
seems like the vending machine is somehow embedded in the maps instead of being stored in a single 
file. The following files are located in SCENE/0x and they are already confirmed to contain the 
vending machine textures. Replace the European ones for the Japanese ones. 
 
Location   Folder  File 
Sakuragaoka    JD00   JD00.PKF and JD00.PKS 
Dobuita    D000   OMG.PKF and OMG.PKS 
Bar Yokosuka   DBYO  MPK00.PKF and MPK00.PKS 
New Yokosuka Harbor  MFSY  MPK00.PKF and MPK00.PKS 
Harbor lounge   MKYU  MPK00.PKF and MPK00.PKS 
 
This list may be incomplete. Search the map folders for vending machine textures (chapter 14.2). 
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10 Test image creation 
You have to make tests in order to find out how good your work is. 
The best way to do it is testing an image of your game on an emulator because you won’t need to 
compress and burn the images on CD-Rs. This will save you a lot of money. 
In order to do that you need to know how to create a bootable CDI image of your modified game.  
Search in the root folder of a disc you want to test for a file called “IP.bin”.  
If “IP.bin” was not in the directory then navigate to the “Tools” folder of “Bootmake” and copy the 
file to the folder of the disc you want to test.  
Now copy “binhack32.exe” to the folder where your image is, start it and fill in the gaps like this: 

 

This will patch your IP.bin file and prevent freezing at the game startup. Open “Bootmake”. 

 
 
Browse for your disc’s directory as source directory.  
Browse for the IP.bin file in your disc’s folder. MAKE SURE YOU DID NOT FORGET T HIS!  
Choose a destination for the image file.  
Hit “Make”. A command line window will appear. This will take a while now. Wait until a light blue 
colored “Woohoo... All done OK!” appears.  
Your .cdi test image is now created and you can test it on your nullDC emulator. 

If you have problems with testing the image (game freezes at SEGA screen etc.) try patching 
your IP.bin one more time with binhack32 before creating the image. 
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11 Testing 
NullDC is considered by many users as the best Dreamcast™ emulator so it will be used here. 
Start nullDC. Go to File > Normal Boot and choose your .cdi image. The game should start and you 
may have a look at your work. 

 

nullDC needs DirectX 9 to work properly. Make sure you installed it before testing. 
You can change the controller configuration in “Options > Maple > Port A > config key for Player 1”. 

 

Make sure you switched the subtitles on! To enable them you have to go to Settings > Dialog & 
Text in the Shenmue™ main screen menu and switch it to “Game Mode”. 
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12 Sources 
This guide would not exist without the following resources: 
http://www.hiei-tf.fr/shenmue1-howtotranslate-english.html 
http://shenmuesubs.sourceforge.net/howto.php 
http://shenmuesubs.sourceforge.net/specs.php 
http://shenmuesubs.sourceforge.net/download.php 
http://theisozone.com/tutorials/dreamcast/burning-and-backup/the-difference-between-gdi-and-cdi/ 
http://fileforums.com/showthread.php?t=50423 
http://shenmueangel.free.fr/ 
http://www.shenmuedojo.net/forum/viewtopic.php?f=3&t=43133 
http://www.metagames-eu.com/forums/dreamcast/projet-traduction-des-sous-titres-de-shenmue-1-et-
2-a-65066.html 
http://www.shenmuedojo.net/forum/viewtopic.php?t=3332&postdays=0&postorder=asc&start=25 

Special thanks to:  

Shentrad Team  Tools 
Hiei-   Original guide 
IlDucci   AFS Utils (XML), FREE0x, A0100 and AFS container list 
Wude   Vending machine file swapping  
Master Kyodai  Disc scene list 
Mestre Ziming  Character ID list 

13 Document history 
Version Date Changes Chapter Responsible 

0.8.0 2012-04-22 Completed All  Shensoul 
0.8.1 2012-04-24 AFS container list 14.1 Shensoul 
0.8.2 2012-04-25 PKF containers 9.2.2 Shensoul 
0.8.3 2012-04-27 Translation hint 7.2.2 Shensoul 
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14 Appendix 
Possibly useful information: 

14.1 AFS container list 
Disc 1 
01BEDA - Bad ending: Lan Di returns to Hazuki Resid ence (all disks) 
01BEDB – Bad Ending: Shenhua warning (all disks) 
01BUS - Japanese text, no need to edit (all disks) 
01CAT1 - Ryo finds Megumi with the kitten 
01FULB - Nozomi cries because of her mother (all di sks) 
01JUCE - Subtitles of the soda drinking cutscene (a ll disks) 
01JUCEA- Wang asks Ryo for a drink, Ryo asks him ab out the Chinese letter 
01KAK - Ryo tells Fuku-san that he has a lead on th e chinese cartel 
01KOZ - Game start, Ine-san gives the first allowan ce to Ryo (disks 1 & 2) 
01LET - Ryo finds Iwao Hazuki's farewell letter 
01MEM - Ryo talks with Fuku-san about Iwao's farewe ll letter 
01MIR - Ine-san tells Ryo that Iwao left something at the antique shop 
01MUT - Nozomi asks Ryo to open himself up (disks 1  & 2) 
01NEK - Japanese text, no need to edit 
01NVE - Fight against Enoki and the other thug that  is attacking Nozomi 
01REV - Sailors attempt to ambush Ryo, gets info ab out the tattoo parlor 
01SKI - Ryo talks with Nozomi about leaving Japan ( disks 1 & 2) 
01SKIA - Nozomi calls Ryo to meet at Sakuragaoka Pa rk (disks 1 & 2) 
01TEL - Searching the 61 area code on the phone boo k (all disks) 
01YOB - Nozomi talks with Ryo after his fight with Charlie 
 
A0100 - Demo trailer of the game, Shenhua intro seq uence 
A01103 - After Iwao's death, postman brings the Chi nese letter 
A01114 - QTE against Tony and Smith at the Heartbea ts Bar alley 
A01124 - Ine-san gives the letter in chinese to Ryo  
A0114 - Game intro, Iwao Hazuki dies by the hand of  Lan Di 
A0119 - (Ryo's making gestures) Unsubbed cinematic 
A0122 - Ryo's childhood memory: Iwao Hazuki makes h im eat vegetables 
A0125 - Ryo tells Fuku-san that he must avenge his father's murder 
A0125A - Ryo tells Fuku-san that he must avenge his  father's murder 
A0125B - Childhood memory: Iwao speaks about the im portance of friendship 
A0128 - Childhood memory: Iwao teaches Ryo martial arts (under cherry tree) 
A0134 - Japanese text, no need to edit 
A0136 - End of Charlie's tattoo parlor QTE, he talk s about the cartel 
A0136A - Beginning of Charlie tattoo parlor QTE, To ny & Smith make a run 
A0139 - Ryo and Fuku-san speak about the Chinese le tter 
A0142 - Japanese text, no need to edit 
A0142B - Russiya China Shop's Xia Xiu Yu translates  the letter in Chinese 
A0173 - Fuku-san forces Ryo to sleep in bed for all  the day (all disks) 
 
E1001D - Work - Tutorial for driving a forklift. (d isks 1 & 3) 
E1002 - Fight against Tony and Smith while searchin g for Jimmy 
E1003 - End of the QTE fight against Charlie at Sak uragaoka 
E1011 - Ryo finds the markings and locks of the sec ret wall (disks 1 & 2) 
E1014A - First QTE where Ryo has to catch a soccer ball 
E1017 - Fuku-san asks Ryo to teach him the Pit Blow  move 
E1012 - Ryo investigates Hazuki Dojo's hidden basem ent 
E1018 - Subtitles (Hazuki Residence) related to ite ms and stuff (all disks) 
E1020 - Yamagishi-san teaches Ryo the Double Blow m ove 
E1024 - Subtitles seen at You Arcade/Slot House (al l disks) 
E1025 - Subtitles seen at You Arcade, Darts game. ( all disks) 
E1026 - Subtitles seen at You Arcade, Excite QTE. ( all disks) 
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E1027 - Subtitles seen at You Arcade, Space Harrier /Hang-On (all disks) 
E1030 - Ryo busts into Heartbeats Bar, QTE against the locals 
E1031 - Subtitles (Hazuki Dojo) while sparring agai nst Fuku-san (all disks) 
E1032 - Subtitles of all the phone calls / characte rs (all disks) 
E1036 - QTE fighting against the two brats that are  with Mai (disks 1 & 2) 
E1039 - Subtitles of MJQ Jazz Bar's base workers (p laying pool) (all disks) 
E1040 - Subtitles when training moves at an empty a rea (all disks) 
E1041 - Subtitles related to the Yamanose Shrine's kitten (all disks) 
E1044 - A lady at Sakuragaoka Park is trying to fin d the Yamamoto's House 
E1049 - Fight & QTE at Sakuragaoka (Charlie steals soccer ball of a kid) 
E1060 - Ryo's comments when reading Move Scrolls an d Letters (all disks) 
E1064 - First fight against Enoki and the other thu g 
E1065 - Second fight against Enoki and the other th ug 
E1066 - Subtitles found when using the Capsule Toy Machines (all disks) 
E1067 - Subtitles found when using the Jukeboxes (a ll disks) 
E1068 - End of ambush at You Arcade, Tony gives inf o on Tattoo Parlor 
E1072 - Subtitles related to the Lapis Adivination (all disks) 
E1076 - Subtitles related to the Slot Machines (all  disks) 
E1079 - Subtitles related to Batteries/Use of batte ries (all disks) 
 
SA1007 - Ryo in MJQ Jazz Bar asking for sailors bef ore the bar's open. 
SA1008 - Japanese text, no need to edit 
SA1009 - Ryo asks Akemi (Yokosuka Bar) about sailor s 
SA1010 - Bar Yokosuka keeper tells Ryo that he can' t serve him alcohol 
SA1012 - Ryo finds the Tattoo Parlor, but it's clos ed 
SA1060 - Subtitles related to shopping at the Antiq ue Shop (all disks) 
SA1062 - Ine asks Ryo to get back into the house be fore 11PM (all disks) 
SA1063 - Ine-san argues with Ryo about arriving lat e at home (all disks) 
SA1071 - Ryo stops trying to find something on the Phone book 
SA1076 - Lines about having not much money / return ing home (all disks) 
SA1077 - Ryo swears he'll avenge his father, Fuku-s an asks for sparring 
SA1079 - Subtitles about shopping at Tomato Conveni ence Store (all disks) 
SA1080 - Subtitles about trying to enter a closed s hop (on all disks) 
SA1081 - Duplicate of previous file (all disks) 
SA1082 - Ryo trying to exit Hazuki Residence before  talking with Fuku-san  
SA1083 - Heartbeats Bar's owner kicks Ryo out 
SA1084 - Heartbeats Bar's owner kicks Ryo out, extr a subs 
SA1085 - Subtitles related to shopping at Abe Store  (Found on all disks) 
SA1086 - Subtitles about having to talk with more p eople (all disks) 
SA1087 - Subtitles about having to talk with more p eople / Yamagishi-san 
SA1088 - Subtitles related to Ryo finding a closed door (all disks) 
SA1089 - No visits to harbor before finding Phoenix  Mirror (disks 1 & 2) 
SA1091 - Subtitles about a shop closing while still  inside (all disks) 
SA1092 - Japanese-only subtitles (disks 1 & 3) 
SA1095 - Ryo doesn't want to leave before buying a ticket (disks 1 & 2) 
SA1100 - About finding Warehouse #8 via area code o n the phone book. 
SA1101 - Subtitles about Ryo in a hurry (Nozomi's k idnapped) (disks 1 & 3) 
SA1102 - Subtitles about Ryo picking up his allowan ce. (all disks) 
SA1116 - Ryo asks Fuku-san about the men who killed  Iwao 
SA1119 - Subtitles related to picking up the Hong K ong ticket (disks 1 & 2) 
SA1120 - Subtitles about waiting for Jimmy's call ( ticket) (disks 1 & 2) 
SA1121 - Subtitles about the You Arcade date for th e ticket (disks 1 & 2) 
SA1122 - Subtitles after the fight against Chai at You Arcade (disks 1 & 2) 
 
SY01 - Japanese-only subtitles (Found on all disks)  
SY02 - Japanese-only subtitles (Found on all disks)  
SY03 - Japanese-only subtitles (Found on all disks)  
SY04 - Japanese-only subtitles (Found on all disks)  
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SY05 - Japanese-only subtitles (Found on all disks)  
SY06 - Japanese-only subtitles (Found on all disks)  
SY07 - Subtitles related for being too late and ret urning home (all disks) 
SY08 - Subtitles related for being too late and ret urning home (all disks) 
SY09 - Subtitles related for being too late and ret urning home (all disks) 
SY10 - Subtitles related for being too late and ret urning home (all disks) 
SY11 - Subtitles related to not spending more money  (all disks) 
 
Disc 2 
01BEDA - Bad ending: Lan Di returns to Hazuki Resid ence (all disks) 
01BEDB – Bad ending: Shenhua warning (all disks) 
01BNK - "Guess Hong Kong's out." 
01BTU - Nozomi brings flowers to Ryo's house 
01BUS - Japanese text, no need to edit (Found on al l disks) 
01CAT3 - Kitten's leg is healed 
01DIS - Ryo shows the Mirror to Fuku-san, he thinks  Ryo's possessed 
01EAR - Ryo asks Ine-san some money for the Hong Ko ng trip 
01ETU - Ryo tries to talk with Asia Travel Co.'s gi rl 
01FRE - Fuku-san's friends are worried about Ryo 
01FRO - Two security guards kick the homeless guy o ut of a warehouse 
01FULB - Nozomi cries because of her mother / she h as to leave (all disks) 
01GAK - Naoyuki and Ichiro go to Ryo's house to see  him 
01GAR - Goro and his pal distract a guard so Ryo ca n get inside a warehouse 
01HIS - Mai asks some money from Hisaka-san, she re fuses 
01HOK - Ryo shows Xia-san the Phoenix Mirror, talki ng about stars 
01INY - Ryo shows Yamagishi-san the Phoenix Mirror 
01JIM - QTE when chasing Jimmy on Dobuita 
01JIMB - Beginning of the QTE chase against Jimmy 
01JUCE - Subtitles of the soda drinking cutscene (a ll disks) 
01KEI - Ryo shows Oishi-san the Phoenix Mirror 
01KOZ - Game start, Ine-san gives the first allowan ce to Ryo. (disks 1 & 2) 
01MIR - Ine-san tells Ryo that Iwao left something at the antique shop. 
01MIT - Ryo talks with owner of Global Travel Agenc y about a Hong Kong trip 
01MON - Fuku-san shares his money with Ryo and tell s him about cheap ticket 
01MUT - Nozomi asks Ryo to open himself up (disks 1  & 2) 
01OKO - Ryo says goodbye to Fuku-san after buying t he ticket at Asia Travel 
01SKI - Ryo talks with Nozomi about leaving Japan ( disks 1 & 2) 
01SKIA - Nozomi calls Ryo to meet at Sakuragaoka Pa rk (disks 1 & 2) 
01SOR - Fuku-san confess to Ryo that he told Ine-sa n everything he knew 
01TAZ - Ryo asks Fuku-san if he knows of a cheap tr avel agency. 
01TEL - Searching the 61 area code on the phone boo k. (all disks) 
 
A0132 - Ryo obtains the Sword Handguard from the An tique Shop 
A0154 - Ryo meets for the first time Gui Zhang and Master Chen 
A0159 - Ryo meets Gui Zhang & Master Chen after obt aining the mirror 
A0160 - Ryo & Fuku-san talk about the Chen meeting 
A0165 - Ryo finds out that Asia Travel stole his Ho ng Kong ticket money 
A0167 - Gui Zhang unveils himself as Ryo's bodyguar d, spars to test him out 
A0169 - Jimmy phone calls Ryo to "give him his tick et" at You Arcade 
A0172 - Start of the fight against Chai at You Arca de 
A0172A - End of the fight against Chai at You Arcad e 
A0173 - Fuku-san forces Ryo to sleep in bed for all  the day (all disks) 
A1136 - Ryo shows Ine-san the Sword Handguard 
 
E1004A - QTE when chasing Jimmy through Dobuita's s treets 
E1005 - A druk tries to fight with Ryo 
E1006 - Subtitles when searching for Old #8 and the  guards patrolling 
E1008 - Ryo tries to sneak into the New Warehouse # 8 
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E1009A - Japanese text, no need to edit 
E1009B - Subtitles when searching around / overhear ing that Old #8 exists 
E1010 - Ryo searches around Old #8 
E1011 - Ryo finds the markings and locks of the sec ret wall (disks 1 & 2) 
E1012 - Ryo investigates the Hazuki Dojo's hidden b asement 
E1018 - Subtitles related to Hazuki dojo stuff (all  disks) 
E1024 - Subtitles seen at You Arcade/Slot House (al l disks) 
E1025 - Subtitles seen at You Arcade, Darts game. ( all disks) 
E1026 - Subtitles seen at You Arcade, Excite QTE. ( all disks) 
E1027 - Subtitles seen at You Arcade, Space Harrier /Hang-On (all disks) 
E1031 - Subtitles (Hazuki Dojo) while sparring agai nst Fuku-san (all disks) 
E1032 - Subtitles of all the phone calls / characte rs (all disks) 
E1036 – QTE, fighting against the two brats that ar e with Mai (disks 1 & 2) 
E1039 - Subtitles of Jazz Bar's workers that are pl aying pool (all disks) 
E1040 - Subtitles when Ryo is going to train at an empty area (all disks) 
E1041 - Subtitles related to the Yamanose Shrine's kitten (all disks) 
E1042 - Ryo speaks with homeless (harbor) about the  old district 
E1046 - QTE against Goro and his pal at the harbor 
E1060 - Ryo's comments when reading Move Scrolls an d Letters (all disks) 
E1061 - Ryo delivers the lunchboxes at the Old Ware house District. 
E1066 - Subtitles found when using the Capsule Toy Machines (all disks) 
E1067 - Subtitles found when using the Jukeboxes (a ll disks) 
E1072 - Subtitles related to the Lapis Adivination (all disks) 
E1076 - Subtitles related to the Slot Machines (all  disks) 
E1079 - Subtitles related to Batteries/Use of batte ries (all disks) 
E1081 - Goro starts a conversation with Ryo. 
 
Q1003 - QTE at the beginning of the Old Warehouse D istrict infiltration. 
 
SA1018 - Ryo's friends are at the Dojo. 
SA1035 - Ryo tries to enter to the Old Warehouse Di strict (guard posted) 
SA1036 - Japanese text, no need to edit. 
SA1037 - Ryo asks Fuku-san about the Sword Handguar d. 
SA1039 - Ryo tries to enter the Old Warehouse Distr ict (office entrance) 
SA1060 - Subtitles related to shopping at the Antiq ue Shop. (all disks) 
SA1062 - Ine asks Ryo to get back into the house be fore 11PM (all disks) 
SA1063 - Ine-san argues with Ryo about arriving lat e at home (all disks) 
SA1070 - Japanese text, no need to edit. 
SA1076 - Lines about not enough money and about ret urning home (all disks) 
SA1079 - Subtitles about shopping at Tomato Conveni ence Store (all disks) 
SA1080 - Subtitles about trying to enter a closed s hop. (all disks) 
SA1081 - Duplicate of previous file (all disks) 
SA1085 - Subtitles related to shopping at Abe Store  (all disks) 
SA1086 - Subtitles about having to talk with more p eople (all disks) 
SA1088 - Subtitles related to Ryo finding a closed door (all disks) 
SA1089 - Ryo not going to harbor before finding the  mirror (disks 1 & 2) 
SA1090 - Ryo doesn't want to talk with Ine-san 
SA1091 - Subtitles about a shop closing while still  inside. (all disks) 
SA1095 - Ryo doesn't want to leave before buying a ticket. (disks 1 & 2) 
SA1096 - A guard kicks Ryo out of a restricted area . 
SA1097 - A guard kicks Ryo out of a restricted area .  
SA1098 - A guard kicks Ryo out of a restricted area .  
SA1099 - A guard kicks Ryo out of a restricted area . 
SA1102 - Subtitles related to Ryo's picking up his allowance. (all disks) 
SA1104 - Subtitles related to locked doors 
SA1108 - Ryo asks Gui Zhang to translate the Stab A rmor move scroll. 
SA1109 - Ryo asks Gui Zhang to translate the poetry  scroll. 
SA1114 - Subtitles related to shopping at the Tomat o Convenience Stores 
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SA1115 - Subtitles about returning home (late / nee d to talk with Fuku-san) 
SA1117 - Ryo talks with Ine-san about the Sword Han dguard. 
SA1118 - Ryo talks with Fuku-san about the trip to Hong Kong. 
SA1119 - Subtitles related to picking up the Hong K ong ticket (disks 1 & 2) 
SA1120 - Subtitles about waiting for Jimmy's call ( ticket) (disks 1 & 2) 
SA1121 - Subtitles about the You Arcade date for th e ticket (disks 1 & 2) 
SA1122 - Subtitles after the fight against Chai at You Arcade (disks 1 & 2) 
 
SY01 - Japanese-only subtitles (Found on all disks)  
SY02 - Japanese-only subtitles (Found on all disks)  
SY03 - Japanese-only subtitles (Found on all disks)  
SY04 - Japanese-only subtitles (Found on all disks)  
SY05 - Japanese-only subtitles (Found on all disks)  
SY06 - Japanese-only subtitles (Found on all disks)  
SY07 - Subtitles related for being too late and ret urning home (all disks) 
SY08 - Subtitles related for being too late and ret urning home (all disks) 
SY09 - Subtitles related for being too late and ret urning home (all disks) 
SY10 - Subtitles related for being too late and ret urning home (all disks) 
SY11 - Subtitles related to not spending more money  (all disks) 
 
Disc 3 
01AYU - End of cutscene where Gui Zhang teaches Ryo  a move 
01BEDA - Bad ending: Lan Di returns to Hazuki Resid ence (all disks) 
01BEDB – Bad ending: Shenhua warning (all disks) 
01BIKE - Ryo asks for Naoyuki's bike at Sakuragaoka . 
01BIKEB - "I wish" song cutscene: "Thanks for savin g me."  
01BUS - Japanese text, no need to edit (all disks) 
01CAU - Ryo talks with Chen & Gui Zhang about the L ong Zha 
01CAUA - Ryo gets his wage and also gets a warning letter from Gui Zhang 
01CBK - End of the Charlie bikes QTE,  Lan Di's sti ll on Amihama 
01CJP - Yamanose Shrine's kitten is finally healed,  jumps from the shrine 
01CRA - Some bikers are terrorizing the old homeles s at the harbor. 
01CTS - QTE where you chase Tony/Smith for question s about Long Zha. 
01CTSA - End of the QTE chase, Tony's got caught an d talks about Long Zha. 
01CTSB - End of the QTE chase, Smith's got caught a nd talks about Long Zha. 
01FULB - Nozomi cries because of her mother / she h as to leave. (all disks) 
01GET - Ine-san mentions that Nozomi's missing, Cha i calls Ryo to harbor 
01GHO - Goro and Mai talk about getting married. 
01GMO - Subtitles related to waking up and going to  work. 
01GOHA - Ryo asks Goro for help so he can find a jo b. 
01GOJ - Ryo tries to ask Goro about the Mad Angels,  he tries to get away. 
01GORA - Goro and Mai tell Ryo they found him a job . 
01HOK - Ryo shows Xia-san the mirror, talking about  stars (disks 2 & 3) 
01INY - Ryo shows Yamagishi-san the Phoenix Mirror.  (disks 2 & 3) 
01JIB - Fuku-san is worried about Ryo (they talk), after QTE Chase (Jimmy) 
01JIN - Nozomi's asking for a wish at the Yamanose Shrine. 
01JUCE - Subtitles of the soda drinking cutscene (a ll disks) 
01KUB - Ryo's fired from Alpha Trading Office. 
01LFT - Free Fight ambush of many thugs 
01MAD - Two Mad Angels throw Mark's lunch to the se a, Ryo intervenes 
01MAK - Ryo meets Yada-san and Mark, start of the f orklift tutorial. 
01MKB - Mark takes second beating, tells Ryo his br other was murdered  
01MKJ - Mark tells Ryo that the Long Zha will take place soon. 
01MSO - Empty subtitles related to Iwao Hazuki  
01PHO - Eri takes two pictures of Ryo and Nozomi, R yo has to pick one. 
01ROO - Japanese text, no need to edit 
01TAP - Ryo meets Terry, Terry asks him to take dow n Gui Zhang. 
01TEL - Searching the 61 area code on the phone boo k. (all disks) 
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01TLY - 70 People Fight - Terry's caught, tries to hit Gui Zhang again  
01TLYA - 70 People Fight - A thug takes Ryo to Gui Zhang 
01TLYB - 70 People Fight - Terry invites Ryo and Gu i Zhang to hell. 
01TLYC - 70 People Fight - Ryo and Gui Zhang start the 70 people fight. 
01TLYD - 70 People Fight - Ryo pulls Terry up / Lan  Di already on a boat. 
01TLYE - 70 People Fight - End of section 
01TOMA - Ryo sees Tom, Tom treats Ryo to lunch. 
01TOMB - Tom tells Ryo he's going back to the State s 
01TOMC - "My friend... Tom." Ryo sees a plane and t hinks about Tom. 
01TOU - Some thugs attempt to ask an "insurance" to  Ryo, start of a fight. 
01TSM - Japanese text, no need to edit. 
019RN - Goro's attacked, Ryo is QTE ambushed by fiv e people.  
 
A0173 - Fuku-san forces Ryo to sleep in bed for all  the day (all disks) 
A0174 - Disc 3 start: Ryo faces Jimmy at Asia Trave l. 
A0180 - Fuku-san gives some money to Ryo just befor e he leaves Japan. 
A0184 - Pre-endgame - Chai drops an iron beam to Ry o that hits Gui Zhang 
A0184B - Pre-endgame - Chai fights against Ryo. 
A0184C - Pre-endgame - Ryo throws Chai to the sea 
A0184D - Pre-endgame - Ryo defeats Chai and gets so me info on Lan Di. 
E1001A - Work - Worktime's over, subtitles related to the wage obtained. 
E1001B - Work - Subtitles about moving a crate into  a restricted area. 
E1001C - Work - Mark instructs Ryo with the goal of  each day. 
E1001D - Work - Tutorial for driving the forklift. (Found on disks 1 & 3) 
E1001E - Work - Ryo comments about the breaks and w here to take the crates 
E1011 – Ryo finds the markings and locks of the sec ret wall (disks 2 & 3) 
E1012 - Ryo investigates the Hazuki Dojo's hidden b asement. (disks 2 & 3) 
E1016 - Pre-endgame - Gui Zhang and Chen meet Ryo a t the ship 
E1018 - Subtitles about items and stuff in Hazuki r esidence (all disks) 
E1019 - Gui Zhang teaches the Swallow Dive at the h arbor. 
E1021 - Tom teaches Ryo his Tornado Kick before say ing goodbye. 
E1022 - QTE ambush from five Mad Angels thugs again st Ryo. 
E1023 - QTE chase against Tony / Smith 
E1024 - Subtitles seen at You Arcade/Slot House (Fo und on all disks) 
E1025 - Subtitles seen at You Arcade, Darts game. ( Found on all disks) 
E1026 - Subtitles seen at You Arcade, Excite QTE. ( Found on all disks) 
E1027 - Subtitles seen at You Arcade, Space Harrier /Hang-On (all disks) 
E1031 - Subtitles on Dojo, while sparring against F uku-san (all disks) 
E1032 - Subtitles of all the phone calls / characte rs (all disks) 
E1037 - Subtitles seen in the middle of the 70 peop le fight. 
E1039 - Subtitles Jazz Bar's base workers that are playing pool (all disks) 
E1040 - Subtitles when Ryo is going to train at an empty area (all disks) 
E1041 - Subtitles related to the Yamanose Shrine's kitten (all disks) 
E1045 - Final del enfrentamiento entre Ryo y Gui Zh ang, Terry intenta 
golpear a Gui Zhang con una barra de metal. 
E1047 - Frases que se dicen durante el enfrentamien to entre Ryo y Gui 
Zhang. 
E1060 - Ryo's comments when reading Move Scrolls an d Letters on the 
inventory. (Found on all disks) 
E1062 – Some phrases from Chai 
E1063 – homeless from the harbor teaches Ryo moves 
E1066 - Subtitles found when using the Capsule Toy Machines. (all disks) 
E1067 - Subtitles found when using the Jukeboxes. ( all disks) 
E1069 - QTE fight against three bikers, Charlie amo ng them. 
E1070 - QTE race against the bikers at the harbor. 
E1071 - QTE fight at the harbor, thugs re-attempt t o steal money from Ryo 
E1072 - Subtitles related to the Lapis Adivination.  (Found on all disks) 
E1073 - Ryo gets the information about the Mad Ange ls base  



<Crew Logo> <Crew Name> 
Homepage: 
<Homepage> 

Contact: 
<Contact> 

File ID: 
S1_JPG_083.pdf 

Title: 
Shenmue Japanization Guide 

Version: 
0.8.3 

Date: 
2012-04-27 

Effective for: 
<Project> 

Created: 
2012-04-27 Shensoul 

Classification: 
DRAFT 

Approved:  
<Date> <Name> 

 

<Crew Name> Shenmue Japanization Guide Page 24 of 32 

E1076 - Subtitles related to the Slot Machines. (al l disks) 
E1077 - Ryo reaches the harbor trying to find Nozom i 
E1078 - Subtitles related to the forklift races. 
E1079 - Subtitles related to Batteries/Use of batte ries (all disks) 
E1081 - Goro starts a conversation with Ryo. (disks  2 & 3) 
 
SA1035 - Ryo tries to enter to the Old Warehouse Di strict (disks 2 & 3) 
SA1039 - Ryo tries to enter the Old Warehouse Distr ict (disks 2 & 3) 
SA1053 - Ryo asks Ono for his bike, Ono-san mention s Naoyuki has one. 
SA1060 - Subtitles related to shopping at the Antiq ue Shop. (all disks) 
SA1062 - Ine asks Ryo to get back into the house be fore 11PM (all disks) 
SA1063 - Ine-san argues with Ryo about arriving lat e at home. (all disks) 
SA1076 - Lines related to having not much money (al l disks) 
SA1079 - Subtitles about shopping at Tomato Conveni ence Store (all disks) 
SA1080 - Subtitles about entering a shop that's clo sed. (all disks) 
SA1081 - Duplicate of previous file. (Found on all disks) 
SA1085 - Subtitles related to shopping at Abe Store . (Found on all disks) 
SA1086 - Subtitles about having to talk with more p eople. (all disks) 
SA1088 - Subtitles about closed doors. (all disks) 
SA1091 - Subtitles related to a shop closing while still inside (all disks) 
SA1092 - Japanese-only subtitles (Found on disks 1 & 3) 
SA1093 - Goro scolds Ryo (he didn't got to Alpha Tr ading in time). 
SA1094 - Fuku-san gives Ryo the photo of a younger Iwao with someone else. 
SA1096 - A guard kicks Ryo out of a restricted area . (disks 2 & 3) 
SA1097 - A guard kicks Ryo out of a restricted area . (disks 2 & 3) 
SA1098 - A guard kicks Ryo out of a restricted area . (disks 2 & 3) 
SA1099 - A guard kicks Ryo out of a restricted area . (Found on disks 2 & 3) 
SA1101 - Subtitles about Ryo in a hurry (Nozomi's k idnapped) (disks 1 & 3) 
SA1102 - Subtitles related to Ryo's picking up his allowance. (all disks) 
SA1103 - Ryo arrives late at Alpha Trading and find s a different foreman. 
SA1104 - Subtitles related to a locked door. 
SA1105 - Mark asks Ryo to arrive to the harbor at 9 AM 
SA1106 - Ryo refuses to leave the harbor because of  the main quest. 
SA1108 - Ryo asks Zhang to translate a move scroll (disks 2 & 3) 
SA1109 - Ryo asks Gui Zhang to translate the poetry  scroll. (disks 2 & 3) 
SA1114 - About shopping at Tomato Stores. (1 is rep eated) (disks 2 & 3) 
SA1115 - Subtitles about returning home / talking w ith Fuku (disks 2 & 3) 
 
SY01 - Japanese-only subtitles (Found on all disks)  
SY02 - Japanese-only subtitles (Found on all disks)  
SY03 - Japanese-only subtitles (Found on all disks)  
SY04 - Japanese-only subtitles (Found on all disks)  
SY05 - Japanese-only subtitles (Found on all disks)  
SY06 - Japanese-only subtitles (Found on all disks)  
SY07 - Subtitles related for being too late and ret urning home. (all disks) 
SY08 - Subtitles related for being too late and ret urning home. (all disks) 
SY09 - Subtitles related for being too late and ret urning home. (all disks) 
SY10 - Subtitles related for being too late and ret urning home. (all disks) 
SY11 - Subtitles related to not spending more money  (all disks) 
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14.2 Vending machine files 
VEND   Vending machine 
ATRK   Winning can (don’t swap this!) 
COKE   Coca Cola® 
SPRT   Sprite® 
FATO   Fanta® Orange 
FATG   Fanta® Grapefruit 
CAFE   Coffee 
HIT   some unidentified smileys (don’t swap this) 
HMOT_CAN.BIN drinking animation 

How to find out if a file has vending machine textures in it: 
You will need pvrext.exe and pvr2png.exe. Create a folder (e.g. C:/X) and 
move pvrext and pvr2png into it. Then create a .cmd  file with the following 
lines in the same folder using your windows editor:  
 
pvrext.exe -e *.pkf C:\X 
pvrext.exe -e *.tmp C:\X 
pvr2png.exe *.pvr 
del C:\X\*.pvr 
 
Open the folder of a map (e.g. SCENE/01/JD00 for Sa kuragaoka) and search 
for texture files (e.g. JD00.PKF) in it. Move one P KF file to your folder 
where the script is. Run your script and wait until  the textures are 
extracted as .png images. If you get error messages  open the file with 
Winrar or 7zip, double-click on your PKF, extract t he TMP file and try 
again extracting the TMP instead of the PKF. You ca n also try to extract 
the PKF from the PAL version if the NTSC-J won’t wo rk. However it’s 
possible that some PKFs won’t extract. If it was ex tracted successfully 
have a look on the PNGs and search for any image wi th vending machine 
textures on it. If you find one it is clear which f ile you need to replace. 

14.3 Disc scene list 
SCENE/01 (Disc 1) 
JD00 - Sakuragaoka (In middle of sakuragaoka at 1/1 ) 
JD99 - Sakuragaoka Beta (0,1,2 hangs) 
JU00 - Yamanose (1/1 being coming from the Hazuki r esidence) 
JU99 - Yamanose Beta (Enter 0,1,2 hangs) 
OP00 - Opening scene (Intro at 1/1) 
OP02 - Intro with shenhua (at 1/1) 
MO99 - Warehouse No. 8 (Beta? at 1/1) 
MK99 - Old Warehouse district (Beta? No guards at 1 /1) 
MF99 - In front of old warehouse district (Beta? Gl itched a bit) 
DYKZ - Nagai Industries 
DURN - Lapis Fortune teller 
DTKY - Maeda Barber shop 
DSUS - Takara Sushi 
DSLT - Slot House 
DSLI - Linda 
DSKI - Global Travel Agency 
DSBA - Yamaji Soba Noodles 
DRSA - Russiya China shop 
DRME - Manpukuken Ramen 
DRHT - Liu Barber and Hair salon 
DPIZ - Bob's Pizzeria 
DNOZ - Nozomi Crying Cutscene 
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DMAJ - Daisangen (Mahjongg Parlor) 
DKTY - Antique shop 
DKPA - Nana's Karaoke Bar 
DJAZ - MJQ Jazz Bar 
DHQB - Heart beats (Beta? Cutscene? Crashes!) 
DGCT - Game You Arcade 
DCHA - Ajiichi Chinese Restaurant 
DCBN - Tomato Convenience Store 
DBYO - Bar Yokosuka 
DBHB - Heart Beats 
DAZA - Asia Travel Company 
D000 - Dobuita 
BETD - Bad ending cutscene (Enter 0) 
0000 - Test area (quite empty) 
YG14 - Crashes 
YD8S - Goro distraction cutscene (Enter 0) 
YD01 - Cherry tree Iwao Fight Flashback 
VEND - Crashes (Vending machine scene i guess) 
TOKI - Russiya China shop (Cutscene? Hangs!) 
TATQ - Tatoo Parlor 
JABE - Abe Store (little baby ryo) 
FREE - Crashes (Not really a scene folder) 
JOMO - Ryo's Room 
JHD0 - Hazuki Residence (outside) 
 
SCENE/02 (Disc 2) 
ARAR - Asia Travel Company Cutscene 
GMCT - You arcade cutscene 
MFSY - New Yokosuka harbor 
MK80 - Translate Scroll cutscene 
MKSG - old warehouse district 
MKYU - Harbor Lounge 
MS08 - Warehouse No 8 
MS8A - Warehouse No 8 
MS8S - Warehouse No 8 
YDB1 - Hazuki Residence Basement 
 
SCENE/03 (Disc 3) 
NBIK - Motorcycle (Nozomi Ryo Motorcycle) 
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14.4 Character ID list 
AKIR Ryo Hazuki AAA_M 
SORY Lan Di KOK_M 
IWAO Iwao Hazuki IWA_M 
JAKR Ryo Hazuki (Childhood) JKB_M 
FUKU Masayuki Fukuhara FUK_M 
INE_ Ine Hayata INE_M 
KISY Chen Gui Zhang KIS_M 
TAIJ Master Chen SYU_M 
CHAI Chai CHA_M 
KURA Man in black A BLA_M 
KURB Man in black B BLB_M 
KAME Kame Shibukawa FUU_L 
JIMY Jimmy Yan JIM_M 
TONY Tony Abrams GIJ_M 
SMTH Smith Bradley GIB_M 
AKMI Akemi Sato HOS_L 
YOKO Yoko Minato HOB_L 
YUKK Yuka Komine X61_L 
SYZU Shozo Mizuki KOG_L 
JUKY Junko Yamamoto YAM_L 
OISI Keizo Oishi KOT_L 
NAMS Natsumi Sakuragi NAT_L 
SETA Setsu Abe SEU_L 
MTUK Mitsuru Kumeta MRU_L 
HORS Takashi Takashiro TAT_M 
SNKC Shinkichi Noda SAK_L 
YOSE Yoshie Aoi BWW_L 
MRIG Mario Grianni MAL_L 
NITO Yuji Nito GAT_L 
TSUC Shingo Mochizuki MCZ_L 
HATO Yoshifumi Hato BAT_L 
ITOI Bukichi Itoi WAP_L 
TURU Noriyuki Tsuruoka SCA_L 
KURI Shiro Kurita KZM_L 
AOKI Motoyuki Aoki BUR_L 
MADA Ichiro Maeda TOK_L 
ETKO Etsuko Sekine JOJ_M 
BUSS Shinya Onoue OGM_L 
TOM_ Tom Johnson AME_L 
HIRA Haru Hirata TUB_L 
HISA Hisaka Sawano FRO_L 
YURI Yuriko Kikuchi FRB_L 
NANS Nanako Shinohara NAN_L 
HRKO Hiroyuki Orihara ORI_L 
AKSK Kazuo Akasaka JEA_L 
MRUA Minoru Asada ASD_L 
HOND Soichi Honda HND_L 
ONRR Liu En Ling ONL_L 
TATM Ryuji Tatsumi DOR_L 
KYUR Liu Ji You KUU_L 
UNO_ Tao Duo Ji CHU_L 
KYOH Kyoko Hayashi KHY_L 
ASDA Xia Xiu Yu KAS_L 
YAMA Shigeo Yamagishi YMG_L 
MISM Fusayo Mishima KYF_L 
KOND Fusako Kondo X77_L 
RNKT Tao Lin Xia FUW_L 
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NORK Noriko Nakamura SHA_L 
KKBN Xie Gao Wen KOM_L 
YOPA Tsuyoshi Takashima 
YOP_L CATM Kitten KC1_M 
KJIY Koji Yabe BIB_L 
PEDR Pedro Warren JNC_L 
PAUR Paulo McCoy PAL_L 
KEBA Tadashi Akita KEB_L 
KEBB Yasutomo Miyagi KVB_L 
KEBC Yoshio Yamagata KVC_L 
KEBD Hirotaka Chiba KVD_L 
SAGA Naoki Shoji SAG_L 
RYBI Lidia Bennett RED_L 
KYAS Cathy Wilkins KYS_L 
SKGK Hideo Shiga SOU_L 
KIM_ Kim Shihan KIM_L 
MIKM Takafumi Mitsuzuka X70_L 
NSMR Yoshihito Nishii X72_L 
MTUR Mitsuko Mitsura MTK_L 
MYKN Kirino Matsuyama KRN_L 
TMNY Naomichi Tsukamoto YAC_L 
MYTY Takuya Maruyama YAE_L 
HROT Hiroko Tahashi HPD_L 
HREO Harue Okuno HPI_L 
SCKO Sachiko Okae HPJ_L 
EIKK Eiko Kusano HPX_L 
KUKT Kyoko Takai HPY_L 
CMAL Lu Tang Chen CMA_L 
SATM Santa Maeno SNT_L 
BIKA Takashi Watanabe MJA_L 
BIKB Takahiro Iwami MJB_L 
TMMR Tomi Maruyama MYT_L 
MEYS Mari Yamashita KAO_L 
TYHG Toya Hasegawa YKZ_L 
KJHS Koji Hase TPL_L 
TYMK Tsuyoshi Murakami RFA_L 
SIND Satoshi Shinoda SND_L 
MASR Masaru Aoi BGA_L 
ONO_ Goro Ono ONO_L 
MIKI Miki Maeda SHB_L 
HATR Mamoru Hattori HTR_L 
YAMO Tatsuhito Yamaoka YMO_L 
NOMR Mitsugu Nomura NMR_L 
MEGM Megumi Mishima SIA_L 
MAYM Mayumi Mishima SIB_L 
YKDM Seiya Kumagai YDA_L 
YOS2 Osamu Murakawa YEB_L 
YOB1 Rumiko Ishiwatari YEC_L 
YOB2 Michiko Miyoshi YED_L 
YJJI Genzo Todaka YEF_L 
SUMI Natsuki Sumiya SMY_L 
KOMN Hiromi Komine KMN_L 
SAJO Teruhiko Saijo BAU_L 
SKMT Yohei Sakamoto SMT_L 
KOTA Kota Mitsui KTA_L 
YASU Yasuo Ito YSO_L 
KAYO Kayoko Ito KYK_L 
TTYA Tatsuya Yamamoto TTY_L 
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SOBA Kiyoshi Yamanaka SBY_L 
ASOU Hiroshi Tamura ASO_L 
HINA Mai Sawano MIB_L 
YSHY Yoshio Yamada FLI_L 
KKEN Kyosuke Nishida NZG_L 
TKNB Akihito Anzai PAN_L 
TOSK Toshiki Kagawa TOS_L 
SERA Takeshi Sera TUW_L 
HMRO Hidekazu Himuro BTM_L 
BSJM Katsutoshi Busujima BTK_L 
BOB_ Bob Dickson BOB_L 
FKSM Kinuyo Sawano FKS_L 
KJMA Shigeru Kojima KJM_L 
NRSK Kazuomi Narasaki NRS_L 
ASNO Haruo Asano SGA_L 
NAKA Noboru Nakatani SGB_L 
NMKI Hiroshi Ueda SGC_L 
YMGC Yosuke Yamaguchi SGD_L 
KOGA Wataru Koga SGE_L 
TMRA Ryozo Yada KWD_L 
MITA Shinobu Mita SGG_L 
YAYI Yayoi Arisugawa YYI_L 
HTSI Hitoshi Numakubo SGH_L 
JOE_ Jo Higuchi JOE_L 
SAKI Saki Shirakura GRL_L 
MIHO Miho Sagawa MIH_L 
ENDO Shozo Endo SGI_L 
YOSI Yoshihiko Tashiro SGJ_L 
TKSA Tsukasa Takagi SGK_L 
TAGW Kazuyuki Tagawa DRV_L 
RYKO Ryoko Hattori JMA_L 
IRIE Yukiko Irie JMB_L 
KURT Masahiro Kurata SGL_L 
HANA Yoshiharu Hanaoka SVA_L 
SIMZ Kenta Shimizu SVB_L 
TTAY Tota Yoshino TPR_L 
DICK Dick Philips GIA_L 
MARK Mark Kimberly GIC_L 
RBRT Robert Wells GID_L 
HARY Harry Thompson GIE_L 
JONZ Jones Henders GIF_L 
TAKI Manabu Takimoto ZZA_L 
HIRI Takeshi Hirai ZZB_L 
TAKE Hiroaki Takeuchi ZZC_L 
AKTG Susumu Aketagawa YGG_L 
TOKI Toki Aida TKI_L 
KNJI Kenji Aoyama GKA_L 
RIKA Rika Sato GKB_L 
STSI Satoshi Nagata KMA_L 
GORO Goro Mihashi KMB_L 
TDSI Tadashi Hama KMD_L 
HRNO Minako Hirano HPF_L 
KUDO Susumu Kudo FSB_L 
MURI Hiroshi Murai FSC_L 
FLD1 Hiromasa Ono FLA_L 
FLD2 Osamu Ushio FLB_L 
FLD3 Seiji Uchishiro FLC_L 
FLD4 Shogo Sugai FLD_L 
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FLD5 Koichi Tsuda FLE_L 
FLD6 Yasuomi Kujirai FLF_L 
FLD7 Atsushi Sayama FLG_L 
FLD8 Mitsuharu Koda FLH_L 
FLD9 Hiroshi Sugiyama SGF_L 
FLDA Yasuo Kusano FLJ_L 
FLDB Takayoshi Hanazawa FLK_L 
FLDC Naomi Koshiba FLL_L 
FLDD Satoru Tsukakoshi FLM_L 
KEBE Tokumasa Kogo KVE_L 
KEBF Shoichi Tezuka KVF_L 
KEBG Shozo Kuga KVG_L 
KEBH Ryosuke Hoya KVH_L 
KEBI Mitsuyoshi Muta KVI_L 
KEBJ Shingo Kanno KVJ_L 
KEBK Tadashi Uwajima KVK_L 
KEBL Sakae Uzawa KVL_L 
YOHI Yohei Kondo YHI_L 
NGAI Akira Nagai ZZE_L 
ITOH Naoyuki Ito RFB_L 
SKRD Ichiro Sakurada NKK_L 
YJIH Yuji Hirano RFC_L 
TJMA Eri Tajima RFD_L 
JONO Kosaku Shirono YPB_L 
UDGW Kimie Udagawa WDB_L 
OKYS Minoru Okayasu OKA_L 
ISDA Akihiro Ishida JMC_L 
MURA Tadashi Muraoka JMD_L 
SNGA Izumi Sunaga JME_L 
MITI Takako Michii JMF_L 
MSTA Yuka Mashita JMG_L 
MRSK Shingo Murasaki PPL_L 
MNWA Kazumi Minowa MIR_L 
HTNK Yoshihide Hatanaka KAZ_L 
HRSK Nozomi Harasaki NZM_M 
NMNO Yumiko Minamino SHX_L 
ISYM Rena Isayama SHY_L 
KYMA Azusa Kayama SHE_L 
ENKI Akio Enoki YAA_L 
NGSM Tetsuya Nagashima YAB_L 
TKHS Kaoru Takahashi THK_L 
HIDE Hideki Tajima TJH_L 
KTRO Kotaro Sumiya SMK_L 
KENI Kenta Iwasaki BCA_L 
YMST Shinichi Yamashita UBA_L 
SNDO Rikiya Shindo BGM_L 
NMTO Junichiro Nemoto FRA_L 
KWMT Hiroshi Kawamoto NPB_L 
TAEN Taeko Nomura OBA_L 
KYSN Kiyoshi Nishida OYA_L 
SATO Arihiro Sato OYB_L 
YSKT Yoshikazu Takahashi OYC_L 
STAK Yukio Satake TOF_L 
IZWA Midori Aizawa FRG_L 
SGRH Suguru Hirano OYD_L 
MTRI Mitsuru Iwata YPA_L 
TERY Terry Ryan ACS_M 
YKHI Wang Guang Ji KHI_L 
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RINS Lin Xiang Xuan RSS_L 
ECHO Yong Zhu Yan QHB_L 
RKKI Liu Gong Hui X32_L 
GRKN Wu Li Xian SSI_L 
MAGO Ryoko Nishizawa QHT_L 
CHRL Charlie Grant BIK_L 
MORN Mohamad Hassan SGM_L 
HDEI Akiim Chant SGN_L 
TEYI Sadam Daei SGO_L 
TOMH Toshimichi Fukui SGP_L 
FLDE Tomo Uemoto FLN_L 
FLDF Shuichiro Ida FLO_L 
FLDG Kyosuke Hatanaka FLP_L 
TMHN Tomohito Niizato KWA_L 
DJUN Taiki Nimura KWB_L 
GJHM Gilbert Flakes HJW_L 
GJBM Wilson Bonett HJB_L 
GJBF Honey Jackson HWB_L 
YUMM Yumi Morino HSA_L 
SYKU Shoko Usui HSB_L 
HTSK Hitoshi Kai SAB_L 
SMIK Sumio Kosuge SAC_L 
SNJY Shinji Yamatani SAD_L 
SINF Ling Sha Hua SIN_M 
GRYU Tomoaki Tange BTA_L 
 
Yukito Tomonari BTB_L 
Makoto Ojima BTC_L 
Tsuyoshi Seino BTD_L 
Yasushi Shima BTE_L 
Kazushi Shoji BTF_L 
Yoshiyuki Tokuchi BTG_L 
Norihiko Kazuhara BTH_L 
Tatsuya Honda BTI_L 
Yuichi Tsuge BTJ_L 
Naomichi Aizawa BTN_L 
Eiji Tonomura BTO_L 
Toshihito Takii BTP_L 
Masaya Tokumitsu CVA_S 
Daisuke Ono CVB_S 
Masamune Tokuda CVC_S 
Kosuke Saito CVD_S 
Kosaku Noda CVE_S 
Tetsu Shimizu CVF_S 
Makoto Kanamori CVH_S 
Shunsuke Tada CVI_S 
Terumasa Moriya CVK_S 
Kyoichiro Konno CVL_S 
Tatsuki Mitsumine CVM_S 
Yoshinori Kondo CVN_S 
Atsushi Kuwata CVO_S 
Fumio Ebina CVP_S 
Motohiro Anzai CVR_S 
Kaname Honjo CVY_S 
Hajime Sato CVZ_S 
Jin Kaido MTB_L 
Rin Kaido 
Akimichi Kunieda NBA_S 
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Kazuhiro Ino NBB_S 
Kiminari Misawa NBC_S 
Masato Wada NBD_S 
Tadatsugu Kimura NBE_S 
Kei Yamashita NBF_S 
Hiroyuki Kiba NBG_S 
Ko Muratani NBH_S 
Tsukasa Ishigaki NBI_S 
Yoshihiro Horiuchi NBJ_S 
Kengo Kamijo NBK_S 
Takeru Majima NBL_S 
Isao Terashima NBM_S 
Yutaka Koizumi NBN_S 
Kentaro Sekizaki NBO_S 
Takayuki Shibata NBP_S 
Akira Fujiwara NBQ_S 
Hiroshi Sakiyama NBR_S 
Takeo Narumi NBS_S 
Shota Yamaguchi NVA_S 
Akihisa Shigematsu NVC_S 
Jin Kano NVD_S 
Hironobu Kikuchi NVG_S 
Kazuki Goya NVI_S 
Jake Lambert NVJ_S 
Makoto Ogishima NVK_S 
Goshi Uchiyama NVL_S 
Shigeki Murayama NVM_S 
Yoshihiro Oguchi NVO_S 
Giichi Imaichi NVQ_S 
Roy Miller NVB_S 
Yoshio Ishikawa CVX_S 
Saburo Yoshino NVR_S 
Ichiro Tano CVU_S 
Masashi Yoneda CVT_S 
Kenichi Okabayashi CVW_S 
Takefumi Kagawa CVV_S 
Jack Nickinen NVU_S 
Fumihiko Hotei NVH_S 
Takichi Yamada NVS_S 
Daisuke Joujima NVP_S 
CATC Cat (black) CT3_M 
CATB Cat (yellow) CT4_M 
CATA Cat (white) CT5_M 
DOGA Dog (brown) DG2_M 
DOGB Dog (white) DG3_M 
EIIU Hidekazu Yukawa YWT_M 


